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Whilst Pegasus Software Limited takes reasonable steps to ensure that the contents of this
manual are up to date, and correctly describe the functioning of the programs, neither Pegasus
Software Limited nor any of its dealers give any warranty that the manual is error free, nor that
the programs will perform all functions stated in the manual. Pegasus Software Limited has
a policy of continual improvement of its software and accordingly this manual may describe
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customers, or which are proposed for a future release of the software. Under no circumstances
will Pegasus Software Limited or any of its dealers have any liability to any customer arising
out of any error, omission or inaccuracy in this manual.
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Pegasus Capital Support Services
Support Services
If you have a query with Pegasus Capital, which you are unable to resolve yourself, we know how important
it is for help to be close at hand.

Capital Service Cover provides you with E-mail support direct with Pegasus Software. This will give you the
ability to log an unlimited number of support issues with our dedicated support team by E-mail over a twelve
month period.

Capital Service Cover can be purchased via the Pegasus Webstore at http://webstore.pegasus.co.uk

Note To assist the support technician, you may be asked to provide information about your Pegasus Capital installation.
Information is recorded in a text file (called CGInfo.txt) which can be opened by clicking the Pegasus Capital
Information icon in your Pegasus Capital folder.

Training
Pegasus Capital has been designed with ease of use in mind. However, to ensure you get the most from your
investment, the Capital Interactive Manual provides a Computer-based Training tool. It provides lessons on
how to use the software in either a ‘Try It’ mode that is interactive and enables you to use the functionality
you have learnt about or a ‘See It’ mode that provides demonstrations on how to use the functionality of
your Capital software.

The Capital Interactive Manual can be purchased via the Pegasus Webstore at http://webstore.pegasus.co.uk

Stationery
To help you to convey a professional image to your customers and suppliers, the Capital Stationery Pack,
provides you with specially designed stationery for your Capital software. The pack includes the following:

• One-part laser statements.

• One-part laser remittance advices.

• One-part laser multipurpose form for use as invoices and credit notes.

All stationery is produced on high-quality laser-compatible cut-sheet paper, which is also suitable for inkjet
printers.

You are guaranteed an exact fit, excellent quality, outstanding service and fast delivery.

The Capital Stationery Pack can be purchased via the Pegasus Webstore at http://webstore.pegasus.co.uk

Pegasus on the Web
You can find out more about products and services available from Pegasus Software Limited by visiting our
website at http://www.pegasus.co.uk

Alternatively, you can E-mail us at mailbox@pegasus.co.uk

http://webstore.pegasus.co.uk
http://webstore.pegasus.co.uk
http://webstore.pegasus.co.uk
www.pegasus.co.uk
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About Pegasus Capital
Find out what Pegasus Capital has to offer

Pegasus Capital is an integrated accounting system designed for small-to-medium-sized companies and
organisations. It is designed to help you be more productive and efficient in your business accounting tasks.
Information is readily available, reports are quick to prepare and there are comprehensive help and search
facilities.

You can maintain records for your accounting system including sales, purchase and nominal ledgers, cash
book, stock control and invoicing.

As you post transactions, the nominal ledger is updated, providing a financial record from which you can
review and analyze your business activities.

The Sales Ledger
Pegasus Capital maintains detailed customer records. It stores information about what has been sold, at what
price and when, when payment is due and the length of time it has been outstanding, as well as credit details
and discounts given. A full history of all customer transactions, outstanding balances, invoices and the status
of outstanding debts is available.

Country and VAT registration numbers are included to conform to EC VAT requirements. Receipts are
recorded using bank style paying in slip references. You can look back and see which receipts were banked
together, and make up the figure which appears on your bank statements. Advance and part receipts are
allowed and discount and amount due is automatically calculated to save you time.

Statements and up to three levels of debt reminder letters can be produced  to encourage settlement of
outstanding invoices. Detailed aged debtor reports indicate outstanding debts and status. There is also a
facility to print a scanned signature on the letters; again, to save time.

Pegasus Capital automatically ‘forward posts’ entries if they are dated after the end of the current accounting
period.

For the purposes of invoicing, any customer may be made eligible for customer (overall) discount and product
quantity (line) discounts. Customers may be linked to the preferred product quantity discount table via
product discount groups.

The Purchase Ledger
The purchase module records supplier details. It maintains information about items bought, dates and prices,
when payments are due and discounts you may be entitled to. A full history of all supplier transactions,
outstanding payments and invoices is available. Country and VAT registration numbers are included to
conform to EC VAT requirements.

Payment reports provide details of creditors requiring payment, together with due dates, allowing you to
control your cashflow by deciding who to pay and when. The system also allows for partial payments and
payments in advance.

Invoices due for payment by a specified date can be identified. If payment is authorised, entries are
automatically created and a remittance advice printed, if requested, saving you time. Settlement discount to
which you are entitled is automatically calculated and reflected in the amount due for payment.

The Nominal Ledger and Cashbook
The nominal module collates the entries in other ledgers to produce a balance sheet and profit and loss
account. Pegasus Capital automatically updates the nominal accounts each time a financial posting is made, so
it always holds the latest information.

The cashbook is integrated with the nominal and provides for bank and petty cash account payment and
receipt postings.
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When creating a company, you can choose a default chart of accounts for your type of business, or you can
set up your own from scratch or amend a default.

Graphs and reports can be produced to compare budgets and prior year figures with actuals. Pegasus Capital
provides the flexibility for you to design your own balance sheet and profit and loss reports.

Postings for recurring transactions can be handled automatically for standing orders, direct debits, and so on.

If you also use Capital Payroll, an import facility is provided so you can import the journal postings for your
nominal accounts according to the analysis of payroll costs.

Invoicing
You can create invoice and credit note documents. Prices, discounts and VAT are calculated automatically
and the sales and nominal accounts updated. For products designated as ‘full stock items’, stock levels are
updated on screen when you raise documents, showing the affect the transaction will have on stock levels. A
warning is given when there is insufficient stock to meet the requirement.

You can print invoices and credit notes on special stationery. The printing of documents can be batch
controlled and carried out at the end of each day, if you prefer. Existing documents can be reprinted.

When creating any document you can offer, in addition to settlement discounts, quantity (line) discounts for
products entered and a customer (overall) discount.

Quantity and customer discounts can be enabled and disabled at both company level and customer level.

Products and Stock Control
The products module helps you keep up to-date information about the products you make, buy and sell. You
can maintain three different types of product: ‘description only’, ‘product only’ or ‘full stock item’.
‘Description only’ items can be used for description lines to include on invoice and credit note documents,
but have no price or other details. ‘Product only’ items record details such as selling prices and available
discounts, but no stock levels are maintained. ‘Full stock item’ products include information such as reorder
levels and quantities, minimum stock levels and quantities in stock. You can also maintain supplier details and
cost price.

Prices can be updated ‘globally’ by supplier and by product range.

For ‘full stock item’ products, stock levels are updated on screen when you receive stock, showing the affect
the transaction has on stock levels.

For the purposes of invoicing, quantity (line) discounts may be assigned to any product that is not a
‘description only’ item.

Management Information and Reports
Pegasus Capital provides you with reports and management information vital to the successful running of a
business. Most of the reports produced by Pegasus Capital can be output directly to the print preview facility,
the printer or a number of file formats. Over 50 standard reports are available to provide you with information
on all areas of your business.

Individual products or groups of products can be allocated a sales or purchase analysis code. These allow
more detailed analysis to be carried out and therefore assist management decision making. Analysis codes in
turn are allocated to a specific nominal code.

Enquiries can be performed on the status of sales, purchase and nominal accounts and products. The detail
lying behind summary information can be viewed using the ‘drill down’ facility; you can see exactly what an
outstanding invoice on a customer’s record was for. The ‘drill down’ facility is also available on the VAT
return report, graphs and status screens.

Cashflow forecasts, aged debt, customer, supplier and product turnover can be illustrated by one of the built-
in graphs. In some circumstances, the ‘drill down’ facility allows you to see the figures and detail which lie
behind each bar of the graph. Graphs can also be exported and transferred to word processing or similar
applications.
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The ‘spike’ provides an intermediate repository for multiple pieces of information to be transferred to another
application.

A status screen provides a summary of the position of your business, including due events, such as a reminder
that a VAT return is due, and financial information such as the amount of cash in the bank, accrued VAT
liability and customer receipts.

VAT Routines
VAT values are calculated whether you use accrued VAT or VAT cash accounting. The report looks like the
HM Customs and Excise VAT 100 form, reducing the risk of mistakes when completing the document you
submit.

The ‘drill down’ facility shows you the detail lying behind the figures in the VAT Return report.

Euro Values
Pegasus Capital provides a facility to record and display values in the Euro currency for certain invoicing
transactions. This facility provides:

! The means to store a home currency description.

! The means to store the current Euro to home currency or home currency to Euro exchange rate.

! An option on each customer record to determine whether a Euro equivalent value should be displayed
adjacent to the home currency total on sales documents.

! A facility to post exchange discrepancies automatically to a specific nominal account.

! A Euro Calculator function that you can use to display conversions between Euro and home currency
values, based on the current exchange rate.
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System Requirements
General
Processor Pentium 90 MHz (higher recommended)

Memory 32 MB RAM

Monitor Super VGA 800x600 (1024x768 recommended) using small fonts

Input Keyboard  and Mouse

Operating system Windows 98 S/E, Windows ME, Windows XP, Windows 2000 SP1

Hard disk space 77 MB (including demonstration data)

Total hard disk space requirement will depend  upon volume of additional data entered.
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Install and Start Pegasus Capital
Your first steps towards using Pegasus Capital

Before you can begin to use your Pegasus Capital system, various tasks need to be carried out to ensure that
the system is installed correctly and that you get the best service from the software. We recommend that you:

• Install the software.

• Understand the basics of  Microsoft Windows.

• Use the demonstration data provided to learn about the basics of Pegasus Capital.

Install Pegasus Capital on Your Computer
Important If you are using a virus-detection utility, disable it before you run the Pegasus Capital Setup program
because it may interfere with installation. Also, close any open applications. It is recommended that you are logged in as
the Administrator, or a user with Administrator rights, when running the Pegasus Capital Setup program. When installing
on a Windows 2000 system, this is mandatory.

!!!!! To install Pegasus Capital

1 Do one of the following

• From the location in which you downloaded Pegasus Capital from the Web, double-click the
Setup.exe program file.

• If you have been supplied with Pegasus Capital on a CD, insert the CD in your computer’s CD-
ROM drive. Provided your PC is setup to use the Autorun feature, the CD will be automatically
detected and the Pegasus Capital Setup wizard will appear.

2 Click Next and the Pegasus Software Ltd Licence Agreement dialog box appears. Read the terms and
conditions provided. To accept these and continue with the setup, click Yes.

3 The Registration details dialog box appears. In the boxes provided, type your name and company name.

4 Click Next and a confirmation of the registration details you entered will appear. If the details are
correct, click Yes to continue, otherwise click No to return to the Registration dialog box to re-enter the
details.

5 The Installation directory dialog box appears, showing where Pegasus Capital will be installed. The
default location is C:\Program Files\Pegasus\CapitalGold. Unless you have a very good reason to
change this, we suggest you accept this default by clicking Next. If you do want Pegasus Capital
installed in a different location, click Browse and select the drive and folder into which the programs
will be installed before you continue.

6 Click Next and the Select Program Folder dialog box appears. A default program folder name of
‘Pegasus Capital’ is shown in the Program Folders box. You can either accept this or select an existing
folder from the Existing Folders list.

7 A confirmation dialog box appears showing the installation details. If any of these are incorrect and you
want to retrace any steps in the installation, click Back. If the details are correct and you want to carry
out the installation, click Next. While the files are being installed, a monitor appears to show you the
progress of the installation.

8 Finally, you will either see a message asking if you want to view the readme file and then prompting you
to reboot your computer, or a dialog box with two options: Yes, I want to view the readme file and
Yes, I want to launch Pegasus Capital. If the dialog box is displayed, select the option(s) you want and
then click Finish to complete the installation.
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Important Notes
Installing on Windows 2000 Having installed Pegasus Capital, you MUST reboot the machine BEFORE actually
using the product. The installation program may offer an option at the end of the installation process to re-boot the
machine. When installing on a Windows 2000 machine, the user currently logged in MUST have Administrator rights. If
not, the installation will not be allowed.

If a user is unsure whether they have sufficient rights, or how to obtain sufficient rights, then they should consult their
System or Network Administrator.

Uninstall log File During the installation of Pegasus Capital, an installation log file (called SETUP.ILG) is created in a
sub-folder of the Program Files folder called InstallShield Installation Information. This contains all the files and
programs required to uninstall the product.

It is highly recommended that, immediately after installation of Pegasus Capital, a backup of this folder is taken to either
floppy disk, or an alternative folder on the hard disk.

Start Pegasus Capital
Once Pegasus Capital has been installed, the Pegasus Capital folder will appear on your Windows desktop.
There will also be a menu option for Pegasus Capital in the Programs section of the Start menu.

!!!!! To start Pegasus Capital for the first time

1 Do one of the following

• Open the Pegasus Capital folder, and then double-click Pegasus Capital.

• Click the Start button, and then click Programs. Click Pegasus Capital, and then click Pegasus
Capital.

The User Login form appears and the User Name list shows a default selection of
ADMINISTRATOR.

2 In the Password box, type password and then click OK.

The Open Company form appears and the default selection is Summer School Limited; a fictitious
company set up for demonstration purposes.

3 Click OK to load the demonstration data company.

Click the user name.

Type the password required to log on.

The OK button is unavailable until the
correct password is entered.
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Activate Pegasus Capital
Record your licence details

When you install Pegasus Capital, you can activate the product by entering the generic activation key of:

N41RZK21

in the Activation Key box on the Licence Details form.

If you subsequently purchase one of the chargeable options, such as Service Cover, Stationery Pack,
Computer-based Training (CBT) and so on, you will be issued with a licence number and activation key that
you must enter in the Licence Details form.

!!!!! To activate Pegasus Capital

1 Having logged on to Pegasus Capital for the first time, on the File menu, click Licence Details.

2 In the Activation Key box, type the code N41RZK21

3 Click OK.

4 Exit Pegasus Capital by selecting the Exit command on the File menu.

5 Start Pegasus Capital and log on again.

Important Remember to restart Pegasus Capital otherwise in order to register the activation key.

Note If you have purchased one of the chargeable options and have been issued with a licence number, follow the
same steps above but also enter the licence number in the box provided.

Type the activation key assigned to you by your
supplier or Pegasus Software Limited.
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Working with Pegasus Capital
Make the most of Pegasus Capital’s features

Before you begin working with Pegasus Capital, it’s a good idea to familiarise yourself with the interface and
the general work procedures common to all parts of the system.

Window Items
Form Application Icon Use this to move, minimise and close windows. It also allows you to switch to other
applications. This item is shown in the upper left corner of each window.

Title Bar This shows the name of the application or command. If there are several windows open at once, the
Title Bar for the active window (the one on which you are working) is shown in a different colour or
intensity.

Menu Bar This displays the menu commands.

Active Window To identify which window is the one you are working on, other open windows will have their
Title Bar in a different colour or intensity, indicating that they are not active.  When you click anywhere on
another window, that window will become the active one. There may be some circumstances where you
cannot select another window until you have completed a process or clicked on a button to carry out an action
or accept a condition.

Status Bar On the left of the Status Bar, the program will display prompts to explain a particular form box.
These are only shown when the cursor is in a box. The Status Bar also indicates the date, the current
accounting period, the user name and whether input is in insert (INS) or overtype mode (blank).

Work Area The space within the Pegasus Capital window in which you can display forms and dialog boxes
relating to Pegasus Capital commands.

Toolbar A bar containing buttons which relate to particular commands in Pegasus Capital. It can be

Menu barToolbar Title bar

Financial
Status

Status barWork Area

Form Close Button

Active Window

Form Application Icon
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modified and include buttons according to your own requirements.

Form Close Button A button that closes the form or window currently open. If used on the main Pegasus
Capital window, it behaves in the same way as clicking Exit on the File menu.

Note You can also close all open forms using the Close All command on the Window menu.

Menus
The menu bar at the top of the screen contains menus such as File, Edit, View, Tools, Parameters,
Maintenance and so on.

A menu displays a list of commands. Some of these commands have an equivalent button on the Toolbar.

To select commands on menus Point to the menu you want and click to open it. Point to the command you
want and click the left mouse button.

Form and Dialog Box Elements
Forms and dialog boxes contain command buttons and various kinds of options which carry out particular
commands or tasks. For example, on the Customer Account Maintenance form you can enter information
about a customer in the boxes and view data associated with the account.

The following table describes the various elements that can appear on forms and dialog boxes.

Check box A square box that is selected or cleared to turn an
option on or off. More than one check box can be
selected.

Command button A button that initiates an action. Most forms have a
Save button to store the data you have entered. Others
have more specific functions. For example, the
Reprint Document command on the Customer
Account Enquiry form reprints a copy of an original
document for the selected transaction. Many dialog
boxes have OK and Cancel commands.

Slider A bar for browsing through records on a form. Moving

Click to select a command.

Some menus have
submenus.

Menu name Access key

Unavailable command

Some menu commands
have shortcut keys.
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the bar to the right scrolls through records to the end
of the database. Moving it to the left scrolls through
records to the start of the database.

Drop-down arrow An arrow on a drop-down combo or list box,
indicating you can view the list by clicking the arrow.

Drop-down combo box A box with a list attached. You can type text into the
box or select from a list of possible entries.

Drop-down list box A box with an arrow next to it. Unlike a drop-down
combo box, you cannot type text into a drop-down list
box.

Label Text attached to any option, box, command, and so
on.

List box Any type of box containing a list of items you can
select.

You cannot type a selection in a list box.

Option button A round button used to select one of a group of
mutually exclusive options.

Spin box A box with up and down arrows that you click to
move through a set of fixed values. You can also type
a valid value in the box.

Tab A labelled group of options used for many similar
kinds of settings. For example, the Financial Details
tab on the Customer Account Maintenance form
groups all boxes related to the financial terms of the
customer record.

Text box A rectangular box in which you can type text. If the
box already contains text, you can select that default
text or delete it and type new text.

Screen Processing
If you are familiar with using applications in Microsoft Windows, you will find entering and editing data in
Pegasus Capital easy to learn. If you are new to using Windows applications, the following will help you
learn.

Data is entered into boxes on forms. A box may be one in which you can enter or edit data, or one in which
the program displays information that you cannot amend.

To enter data into boxes Click the box. If the box is empty, an insertion point (a vertical bar) appears at the
far left side of the box. The text you type starts at the insertion point.

To add data in a box If the box already contains something, click to place the insertion point where you want
to start typing. Make sure the insertion mode is INS (for insert).

To select text in a box Place the insertion pointer at the start point, then drag the pointer across the text you
want to select while holding down the left mouse button. In some cases, you may find that the whole field is
selected by clicking once on any part of a box.

To select an item from a drop-down list Information can be listed in a drop-down list box, such as country
names and other data types, where a limited choice of entries is possible for a particular field. Click the arrow
button by the side of the box and the list appears. Click the item you want.

To select an option button These options are arranged in groups and are mutually exclusive; you can only
select one of the options in the group at a time. Click the option you want. To change the selection, click a
different option.
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To copy and paste text Select the data you want to copy. Press  CTRL+C or CTRL+INSERT or click Copy
on the toolbar. Click the insertion point in the box where you want to copy the data. Press CTRL+V or
SHIFT+INSERT or click Paste on the toolbar.

Searching for Records
Pegasus Capital helps you find the records you want. All records have an ID. For example, this may be a
customer ID for a customer record, a supplier ID for a supplier record, an invoice number for a sales invoice
record, and so on.

These IDs are unique; this means that you cannot have two records with the same ID. Whenever you need to
locate a record, you can use the ID or you can search for the record you want in a variety of different ways.

To find a record using the ID Click the ID box. If you know the correct ID, type the ID in the box and either
press ENTER or TAB. The record will be retrieved and any relevant data displayed in the form or dialog box.

Important When entering or changing an ID, you must press ENTER or TAB for the entry to be accepted.
Clicking in another box will not be sufficient for the software to recognise a changed ID. For example, if you
select a customer to post an invoice and then change the ID before saving the invoice, the new ID will only be
used if you pressed ENTER or TAB.

To find a record using wildcards in the ID box If you do not know the correct ID, but have some idea of how
to identify the record, you can use an asterisk * as a wildcard. For example, typing B* will enable you to
search for records beginning with B. The first record that matches the text you type will be retrieved.

To scroll through the available records Locate a record using the wildcard method. Where there is more than
one record available that matches the wildcard criteria, the Slider will become active. Click the Slider and
drag using the mouse to scroll or use the arrow keys to move backwards and forwards.

Using the Spyglass
Find a record by selecting from a pick list

The Spyglass is activated by a button at the right of ID boxes.

To locate a record with the Spyglass Click the Spyglass button or place the insertion point in the ID box and
press ?. A Pick List is displayed. You can use the scroll bar to browse the list of records. Double-click the
one you want.

Spyglass button

Double-click the record you want.

Use the Scroll Bar to browse the list.

Type text and wildcards to find
a particular record.

Click Search to find a match
to the criteria you type.
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Want to search for a particular record? In the ID Criteria box, type part of the ID and then click Search. The Pick
List displays only matches to the criteria. For example, if your criteria is A, only IDs beginning with A will be listed. You
can also use a wildcard.

Using Find to Search for a Record
Some forms display data in columns. Wherever columns of data are shown, you can pick a column to search
for a record in the list.

Click the column heading for the item you want to use as the basis of your search. The Find window is
displayed.

In the Find What box, type your search criteria. Click Begin With if the text you have entered is at the
beginning of the item. Otherwise, the text you enter may be found at any position. Click Match Case if your
search is to be case sensitive. Click Up or Down to choose the direction of the search. The start point is the
record currently selected in the list.

Use Find with the Spyglass You can use the Find feature in conjunction with the Pick List dialog box displayed
when you use the Spyglass. Click the column heading of the item you want to use as the basis of your search.

Click the column heading of the item to be used for
your search.

Type your search text in the Find What box.

Click to search for a match.

Click Up or Down to search through records
in the list above or below the one selected.

Click Begin With to find a match to your text at
the beginning of the item.

Click Match Case if your
search is case sensitive.
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The Standard Pegasus Capital Toolbar
Several commands are available on the Pegasus Capital toolbar. These provide a simple way to choose
commands you use frequently.

You can use the Toolbars command on the View menu bar to change the size of the buttons and switch the
Tooltips on and off.

Want to know more? Use the tooltips to view the name of each command button on the toolbar.

Using the Spike
The Spike button on the toolbar provides a ‘multi-clip’ function so you can capture selected items from forms
and dialog boxes in Pegasus Capital and build up a clipboard of text that can be transferred to other Windows
applications. For example, you can select all the fields that make up a customer address from the customer
details window and paste it into a word processor to address a letter.

!!!!! To use the spike

1 On the toolbar, click the Spike button. The Spike window appears.

2 Open the form or dialog box open in Pegasus Capital from which you want to copy text.

3 Drag the mouse across the area to be captured. All text in the selected area will be copied to the Spike,
including field headings.

44444 Drag and drop the selected text in the Spike window.

Note When you close the Spike window, you will be asked if you wish to copy the contents to the Windows clipboard.

Tip You can also use the drag and drop method described above to copy one or more fields to other 'drag and drop
aware' applications.

Using the Euro Calculator
Use the Euro Calculator to calculate the equivalent value of an amount according to the exchange rate
specified.

You can choose to enter either a home currency amount or  Euro value and calculate the equivalent. The
default exchange rate stored for the company is used unless overridden.

The tool may be useful when processing order or invoice documents to establish the equivalent value for an
item line.

!!!!! To use the Euro Calculator

1 On the Tools menu, click Euro Calculator.

2 Under Convert from, click to select the option according to whether you want to enter a Euro or a home
currency amount.

3 In the box provided, type the value to be used for the calculation or use the numerical keypad with the
mouse pointer. The result is automatically displayed in the Calculated value in box.

4 If you want to use an exchange rate other than the default shown, clear the Exchange Rate box and enter
the new rate.
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You can cut and paste the converted value into any value box in Pegasus Capital.
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Repair Existing Installation
Recopy the program files for an existing installation

If you already have Pegasus Capital installed on your computer, but need to repair the installation, you can
use the setup wizard to recopy the program files.

Your existing data files are unaffected, but we strongly recommend you back up your data before you install a
new version of Pegasus Capital.

The option to repair an installation can only be used if the version of Pegasus Capital you have installed is the
same as the one you want use for the repair.

Important If you are using a virus-detection utility, disable it before you run the Pegasus Capital Setup program
because it may interfere with installation. Also, close any open applications. It is recommended that you are logged in as
the Administrator, or a user with Administrator rights, when running the Pegasus Capital Setup program. When installing
on a Windows 2000 system, this is mandatory.

!!!!! To repair your existing copy of Pegasus Capital

1 Run thePegasus Capital Setup.exe program you downloaded from the Web or from the CD supplied.

2 Click Next and the Repair or uninstall dialog box will appear.

3 Click Repair and then click Next.

4 Confirmation of the product details is displayed. Click Next to carry out the repair.

5 When the repair is complete, click Finish.
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Uninstall Pegasus Capital
Remove an existing installation of Pegasus Capital

!!!!! To uninstall your existing copy of Pegasus Capital

1 Run thePegasus Capital Setup.exe program you downloaded from the Web or from the CD supplied.

2 Click Next and the Repair or uninstall dialog box will appear.

3 Click Uninstall and then click Next.

4 Follow the instructions on the screen.

Note Some components may be left on the computer. For example, if you have created data files or used the
demonstration data, the \CapitalGold folder will remain.
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